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Paper Set 1 · 01 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
k ର କେଉଁ  ମୂ ଲ୍ୟ ପାଇଁ  ସମୀକରଣ x² + kx + 441 = 0 ର ମୂ ଳଦ୍ୱୟ ସମାନ ହେବ?

A.  ±21

B.  ±42

C.  ±44

D.  ±22

✓

Q2 Quant
ଏକ ବର୍ଗ କ୍ଷେତ୍ର ର ବାହୁ , 16π cm ପରି ଧି  ବି ଶି ଷ୍ଟ ଏକ ବୃ ତ୍ତର ବ୍ୟାସାର୍ଦ୍ଧ  ଅପେକ୍ଷା 5 cm
ଅଧି କ ଅଟେ । ବର୍ଗ କ୍ଷେତ୍ର ର ପରି ସୀମା କେତେ?

A.  48 cm

B.  52 cm

C.  56 cm

D.  64 cm

✓

Q3 Quant
ଜଣେ ଦୋକାନୀ ₹200 ରେ ଗୋଟି ଏ ଜି ନି ଷ କି ଣି  ଏହାକୁ  ₹250 ରେ ବି କ୍ରି   କଲେ । ଶତକଡା
ଲାଭ କେତେ?

A.  25%

B.  20%

C.  30%

D.  15%

✓

Q4 Quant
ଜନ ମୋଟ ଦୂ ରତାର ଦୁ ଇ-ପଞ୍ଚମାଂଶକୁ  9 km/hr ବେଗରେ ଏବଂ ଅବଶି ଷ୍ଟ ଦୂ ରତାକୁ  12
km/hr ବେଗରେ ମୋଟ 6 ଘଣ୍ଟା 48 ମି ନି ଟ ସମୟରେ ଅତି କ୍ର ମ କରନ୍ତି  । 12 km/hr
ବେଗରେ ତାଙ୍କ ଦ୍ୱାରା ଅତି କ୍ର ମ କରାଯାଇଥି ବା ଦୂ ରତା ନି ର୍ଣ୍ଣ ୟ କର ।

A.  43.2 km

B.  28.8 km

C.  48.2 km

D.  34.8 km

✓

Q5 Quant
ନି ମ୍ନ ଲି ଖି ତ ସଂଖ୍ୟାଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  16 ଦ୍ୱାରା ବି ଭାଜ୍ୟ ଅଟେ?

(i) 8914266
(ii) 5282140
(iii) 4674032
(iv) 5463776

A.  କେବଳ ( ii ) ଓ ( iv )

B.  କେବଳ ( i ) ଓ ( iii )

C.  କେବଳ ( ii ) ଓ ( iii )

D.  କେବଳ ( iii ) ଓ ( iv )

✓

Q6 Quant
ଯଦି  a:b=6:17 ହୁ ଏ, ତେବେ (a+b):(b-a) ର ମୂ ଲ୍ୟ କେତେ?

A.  21:13

B.  11:23

C.  13:21

D.  23:11

✓

Q7 Quant
15 ଟି  ତଥ୍ୟର ଏକ ନମୁ ନା ନି ମ୍ନ ଲି ଖି ତ ଭାବରେ ଦି ଆଯାଇଛି : 52.1, 54.7, 51.2, 55.9.
51.2, 57.4, 59.5, 55.9, 52.1, 55.9, 54.7, 52.1, 55.9, 51.2 । ତଥ୍ୟର ଗରି ଷ୍ଠକ
ନି ର୍ଣ୍ଣ ୟ କର ।

A.  52.1

B.  51.2

C.  54.7

D.  55.9

✓

Q8 Quant
X ଓ Y ଯଥାକ୍ର ମେ ₹60,000 ଓ ₹90,000 ନି ବେଶ କରି  ଏକ ବ୍ୟବସାୟ ଆରମ୍ଭ କରି ଥି ଲେ
। 6 ମାସ ପରେ X ତାଙ୍କ ନି ବେଶରେ ₹30,000 ଅଧି କ ନି ବେଶ କରନ୍ତି  ଏବଂ Y ₹30,000
ଉଠାଇ ନି ଅନ୍ତି  । ଯଦି  ବର୍ଷ  ଶେଷରେ ମୋଟ ଲାଭ ₹1,20,000 ହୁ ଏ, ତେବେ Y ଙ୍କ ଅଂଶ
କେତେ?

A.  ₹54,000

B.  ₹60,000

C.  ₹66,000

D.  ₹72,000
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✓

Q9 Quant
ଯଦି  ଗୋଟି ଏ ସଂଖ୍ୟାର 20% କୁ  24 ସହି ତ ଯୋଗ କରାଯାଏ, ତେବେ ଫଳାଫଳ ସମାନ
ସଂଖ୍ୟା ହେବ । ସମାନ ସଂଖ୍ୟାର 80% କେତେ?

A.  24

B.  6

C.  54

D.  44

✓

Q10 Quant
A ଓ B ଏକାଠି  କାମ କରି  ଗୋଟି ଏ କାର୍ଯ୍ୟ କୁ  2 ଦି ନରେ ଶେଷ କରି ପାରି ବେ । B ଏକାକୀ
ସମାନ କାର୍ଯ୍ୟ କୁ  5 ଦି ନରେ ଶେଷ କରି ପାରି ବ । A ଏକାକୀ କେତେ ସମୟ (ଦି ନ ରେ)ରେ
କାର୍ଯ୍ୟ  ର ତି ନି ଗୁ ଣ କରି  ପାରି ବ?

A.  10

B.  20

C.  30

D.  40

✓

Q11 Quant
₹1,589 କୁ  ଏପରି  ତି ନୋଟି  ଭାଗରେ ବି ଭକ୍ତ ହୋଇଛି  ଯେ ପ୍ର ଥମ ଭାଗର ଅଧା, ଦ୍ଵି ତୀୟ
ଭାଗର ଏକ ଚତୁ ର୍ଥାଂ ଶ ଏବଂ ତୃ ତୀୟ ଭାଗର ଏକ-ଅଷ୍ଟମାଂଶ ସମାନ ଅଟେ । ତେବେ ପ୍ର ଥମ
ଓ ଦ୍ଵି ତୀୟ ଅଂଶ ମଧ୍ୟରେ ଧନାତ୍ମକ ପାର୍ଥ କ୍ୟ (₹ ରେ) କେତେ?

A.  227

B.  177

C.  277

D.  77

✓

Q12 Quant
ଏକ ଉତ୍ପାଦ ଉପରେ ହୋଇଥି ବା ଲାଭ 24% ଅଟେ । ଯଦି  ଉଭୟ କ୍ର ୟ ମୂ ଲ୍ୟ ଏବଂ ବି କ୍ର ୟ
ମୂ ଲ୍ୟ ର ସଂଖ୍ୟାଗୁ ଡ଼ି କୁ  ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ତେବେ ବି କ୍ର ୟରେ
ହୋଇଥି ବା କ୍ଷତି  ପ୍ର ତି ଶତ (ଦଶମି କ ଦୁ ଇ ସ୍ଥାନ ପର୍ଯ୍ୟ ନ୍ତ) କେତେ ହେବ?

A.  19.35%

B.  23.01%

C.  19.33%

D.  19.54%

✓

Q13 Quant
ଯଦି  ବାର୍ଷିକ ଭାବେ ଚକ୍ର ବୃ ଦ୍ଧି  ହେଉଥି ବା ବାର୍ଷିକ 5% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ₹y
ମୂ ଳଧନ ଉପରେ 2 ବର୍ଷ ର ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ₹287 ହୁ ଏ, ତେବେ 2 ବର୍ଷ  ପରେ ସମୂ ଳସୁ ଧ
କେତେ ହେବ?

A.  ₹3087

B.  ₹2801

C.  ₹3551

D.  ₹2694

✓

Q14 Quant
P, Q, R, S ଓ T ପ୍ର ଦତ୍ତ କ୍ର ମରେ ଏକ ବୃ ତ୍ତ ଉପରେ ଅବସ୍ଥି ତ ପାଞ୍ଚଟି  ବି ନ୍ଦୁ  ଅଟେ, ଯେପରି କି
PR ଏକ ବ୍ୟାସ ଏବଂ PQ = QR ଅଟେ । ଯଦି  ∠STP = 124° ହୁ ଏ, ତେବେ ∠SPQ ର ଡି ଗ୍ରୀ
ପରି ମାଣ କେତେ?

A.  79°

B.  34°

C.  72°

D.  45°

✓

Q15 Quant
ଦୁ ଇଟି  ବୃ ତ୍ତ ପରସ୍ପରକୁ  A ବି ନ୍ଦୁ ରେ ବହିଃ ଭାବେ ସ୍ପର୍ଶ  କରନ୍ତି  । BC ଉଭୟ ବୃ ତ୍ତର ଏକ
ସାଧାରଣ ସ୍ପର୍ଶ କ ଯାହା ବୃ ତ୍ତଦ୍ୱୟକୁ  ଯଥାକ୍ର ମେ B ଓ C ବି ନ୍ଦୁ ରେ ସ୍ପର୍ଶ  କରେ । ଯଦି  ବୃ ତ୍ତଦ୍ୱୟର
ବ୍ୟାସାର୍ଦ୍ଧ  8 cm ଓ 3 cm ହୁ ଏ ଏବଂ BC = x cm ହୁ ଏ, ତେବେ x2 ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  90

B.  92

C.  94

D.  96

✓

Q16 Quant
ବାର୍ଷିକ 5% ସରଳ ସୁ ଧ ହାରରେ ମୂ ଳଧନ ₹3300 ର ସୁ ଧ କେତେ ମାସରେ ₹440
ହେବ?

A.  32

B.  29

C.  30

D.  36

✓

Q17 Quant
କେଉଁ  ସଂଖ୍ୟାକୁ  60% ବୃ ଦ୍ଧି  କଲେ ଫଳାଫଳ 3490 ହେବ?

A.  2181.25

B.  2362.54

C.  1090.62

D.  1543.75

✓

Q18 Quant
ଦୁ ଇ ଜଣ ବ୍ୟକ୍ତି  X ଓ Y ଯଥାକ୍ର ମେ 14 km/hr ଓ 15 km/hr ବେଗରେ ସମାନ ଦୂ ରତା
ଯାତ୍ରା  କରନ୍ତି  । ଯଦି  X Y ଙ୍କ ଠାରୁ  28 ମି ନି ଟ ଅଧି କ ସମୟ ନି ଅନ୍ତି , ତେବେ ପ୍ର ତ୍ୟେକଙ୍କ ଦ୍ୱାରା
ଅତି କ୍ର ମ କରାଯାଇଥି ବା ଦୂ ରତା କେତେ?

A.  84 km

B.  90 km

C.  60 km

D.  98 km
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✓

Q19 Quant
କୁ  ସରଳ କର ।

A.  

B.  

C.  

D.  

✓

Q20 Quant
A ଓ B ଏକ କାର୍ଯ୍ୟ କୁ  5 ଦି ନରେ, B ଓ C ଏହାକୁ  8 ଦି ନରେ ଏବଂ C ଓ A ଏହାକୁ  10 ଦି ନରେ ସମାପ୍ତ କରି ପାରନ୍ତି  । ତେବେ B ଏକାକୀ ସେହି  କାର୍ଯ୍ୟ ଟି କୁ  ସମାପ୍ତ କରି ବା ପାଇଁ  କେତେ ସମୟ
ନେବେ?

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
କେଉଁ  ଭାରତୀୟ ସହର ଜୁ ନ 18 ରୁ  27 ତାରି ଖ ପର୍ଯ୍ୟ ନ୍ତ ଅନୁ ଷ୍ଠି ତ ହୋଇଥି ବା 'ହକି  ଇଣ୍ଡି ଆ
ମାଷ୍ଟର୍ସ  କପ' 2025 (ପୁ ରୁ ଷ ଓ ମହି ଳା) ଆୟୋଜନ କରି ଥି ଲା?

A.  ଚେନ୍ନାଇ

B.  ମୁ ମ୍ବାଇ

C.  କୋଲକାତା

D.  ନୂ ଆ ଦି ଲ୍ଲୀ

✓

Q22 GA
Who among the following is the first boxer to win a gold medal at
the World Boxing Cup in 2025?

A.  Vijender Singh

B.  Hitesh Gulia

C.  Amit Panghal

D.  Nishant Dev

✓

Q23 GA
Who among the following won the 10 km Austrian Race Walking
Championships 2025?

A.  Bhawna Jat

B.  Khushbir Kaur

C.  Priyanka Goswami

D.  Sapana Punia

✓

Q24 GA
ଓଡ଼ି ଶାର ନଦୀମାନଙ୍କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା କେଉଁ  ନଦୀଗୁ ଡ଼ି କର ଉତ୍ସ ରାଜ୍ୟ ବାହାରେ
ରହି ଛି ?

A.  ବୁ ଢ଼ାବଳଙ୍ଗ, ବୈ ତରଣୀ, ଋଷି କୁ ଲ୍ୟା

B.  ସୁ ବର୍ଣ ରେଖା, ବ୍ରା ହ୍ମଣୀ, ମହାନଦୀ 

C.  ବାହୁ ଡା, ବଂଶଧାରା, ନାଗାବଳୀ

D.  ଇନ୍ଦ୍ରାବତୀ, କୋଲାବ, ମାଛକୁ ଣ୍ଡ
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✓

Q25 GA
କେଉଁ  ଓଡ଼ି ଆ ସମାଜସେବୀ ତଥା ଗାନ୍ଧୀବାଦୀ ବରି  ଠାରେ 'ସେବାଘର' ଏବଂ ପରେ
କଟକରେ 'ଶି ଶୁ  ବି ହାର' ପ୍ର ତି ଷ୍ଠା କରି ଥି ଲେ?

A.  ରମା ଦେବୀ ଚୌଧୁ ରୀ

B.  ମାଲତୀ ଚୌଧୁ ରୀ

C.  ସାରଳା ଦେବୀ

D.  ଅନ୍ନପୂ ର୍ଣ୍ଣା  ମହାରାଣା

✓

Q26 GA
2025 UCI ଟ୍ରା କ ସାଇକ୍ଲିଂ   ବି ଶ୍ୱ ଚାମ୍ପି ଅନସି ପ କେଉଁ ଠାରେ ଅନୁ ଷ୍ଠି ତ ହୋଇଥି ଲା?

A.  ଚି ଲି

B.  ଚୀନ

C.  ବ୍ରା ଜି ଲ

D.  ରୱାଣ୍ଡା 

✓

Q27 GA
ଜୁ ଲାଇ 2025 ପ୍ରା ରମ୍ଭରେ ନୂ ଆପାଟଣା ନି କଟରେ ବୈ ତରଣୀ ନଦୀବନ୍ଧ ଭୁ ଶୁ ଡ଼ି ବା ଘଟଣା
ଓଡ଼ି ଶାର କେଉଁ  ଜି ଲ୍ଲାରେ ଘଟି ଥି ଲା?

A.  ବାଲେଶ୍ୱର

B.  ଯାଜପୁ ର

C.  ଭଦ୍ର କ

D.  କେନ୍ଦ୍ରାପଡ଼ା

✓

Q28 GA
2026–27 ଓଡ଼ି ଶା ବଜେଟରେ ଅଙ୍ଗନବାଡ଼ି  ସେବାର ସୁ ଦୃ ଢ଼ୀକରଣ ନି ମନ୍ତେ କେଉଁ
ଯୋଜନାକୁ  635 କୋଟି  ଟଙ୍କା ପ୍ର ଦାନ କରାଯାଇଛି ?

A.  ସମୃ ଦ୍ଧ ଅଙ୍ଗନୱାଡି  ଯୋଜନା

B.  ସୁ ଭଦ୍ରା  ଯୋଜନା

C.  ମୁ ଖମନ୍ତ୍ରି  କନ୍ୟା ସୁ ମଙ୍ଗଳ ଯୋଜନା

D.  ଆହାର ଯୋଜନା 

✓

Q29 GA
ସି ଭ ଟ୍ୟୁ ବ ସଂରଚନା ଖାଦ୍ୟ ସ୍ଥାନାନ୍ତରକୁ  କି ପରି  ସହଜ କରେ?

A.  ମୋଟା ଭି ତ୍ତି  ଲି କେଜ ପ୍ର ତି ରୋଧ କରେ

B.  ଛି ଦ୍ର ଯୁ କ୍ତ ଭି ତ୍ତି  ଖାଦ୍ୟ ଚଳାଚଳକୁ  ଅନୁ ମତି  ଦି ଏ

C.  ଦ୍ରୁ ତ ପରି ବହନ ପାଇଁ  କୌଣସି  ନ୍ୟଷ୍ଟି  ନଥାଏ

D.  କ୍ଲୋ ରୋପ୍ଲା ଷ୍ଟର ଉପସ୍ଥି ତି

✓

Q30 GA
ଉତ୍ତର ଭାରତ ଦେଇ ଉତ୍ତରରୁ  ପୂ ର୍ବ  ଦି ଗକୁ  କେଉଁ  ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ନଦୀ ପ୍ର ବାହି ତ ହୁ ଏ?

A.  ନର୍ମ ଦା ନଦୀ

B.  ଗୋଦାବରୀ ନଦୀ

C.  ଗଙ୍ଗା ନଦୀ

D.  ତାପୀ ନଦୀ

✓

Q31 GA
ପ୍ରା ଚୀନ ଭାରତୀୟ ସଂଘ ନି ୟମ ଗ୍ର ନ୍ଥ, ଯାହା ସନ୍ନ୍ୟାସୀ ଏବଂ ସନ୍ନ୍ୟାସି ନୀ ମାନଙ୍କର ଆଚରଣ
ଏବଂ ସଂଗଠନକୁ  ନି ୟନ୍ତ୍ରଣ କରୁ ଥି ବା ନି ୟମଗୁ ଡ଼ି କୁ  ସଂକଳି ତ କରି ଥି ଲା, ତାହା ମୁ ଖ୍ୟତଃ
କେଉଁ  ସାହି ତ୍ୟି କ ପରମ୍ପରା ସହି ତ ଜଡ଼ି ତ?

A.  ଔପନି ବେଶି କ ଭାରତର ଆଧୁ ନି କ ସଂସ୍କାରବାଦୀ ଗଦ୍ୟ ସାହି ତ୍ୟ

B.  ବୈ ଦି କ ସାହି ତ୍ୟର ଧର୍ମ ସୂ ତ୍ର

C.  ବୌଦ୍ଧ ସାହି ତ୍ୟର ବି ନୟ ପି ଟକ

D.  ସଙ୍ଗମ ସାହି ତ୍ୟର ଶି ଲାପଦି କରମ

✓

Q32 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ବର୍ଣ୍ଣ ନା କରେ ଯେ, ସସପେନସନ ଗୁ ଡ଼ି କ କାହିଁକି
ଅସମଜାତୀୟ ମି ଶ୍ର ଣ (heterogeneous mixtures) ଅଟେ?

A.  ସସପେନସନରେ ଥି ବା କଣି କାଗୁ ଡି କ ଦୃ ଶ୍ୟମାନ ହୁ ଏ ନାହିଁ

B.  ସସପେନସନ ସର୍ବ ଦା ପରି ଷ୍କାର ଓ ସ୍ୱଚ୍ଛ ଅଟେ

C.  ମି ଶ୍ର ଣରେ ସମସ୍ତ କଣି କାର ବି ତରଣ ଅସମାନ ଅଟେ

D.  କଣି କାଗୁ ଡ଼ି କ ସମଗ୍ର  ମି ଶ୍ର ଣରେ ସମାନ ଭାବରେ ବି ତରି ତ ହୋଇଥାଏ

✓

Q33 GA
କେଉଁ  ଗ୍ୟାସକୁ  ସାଧାରଣତଃ ଲାଫି ଙ୍ଗ ଗ୍ୟାସ ବୋଲି  କୁ ହାଯାଏ ଏବଂ ଏହା ଗ୍ଲୋ ବାଲ
ୱାର୍ମିଙ୍ଗରେ ମଧ୍ୟ ସହାୟକ ହୋଇଥାଏ?

A.  କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ

B.  ନାଇଟ୍ର ସ ଅକ୍ସାଇଡ

C.  ମି ଥେନ୍

D.  ଓଜୋନ

✓

Q34 GA
ସଙ୍ଗମ ସାହି ତ୍ୟ କେଉଁ  ଭାଷାରେ ରଚି ତ ହୋଇଥି ଲା?

A.  ତାମି ଲ

B.  ସଂସ୍କୃତ

C.  ପ୍ରା କୃ ତ

D.  ପାଲି
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✓

Q35 GA
1857 ମସି ହାରେ ପ୍ର ଣୟନ କରାଯାଇଥି ବା ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଆକ୍ଟ ଅନୁ ଯାୟୀ ମୁ ଦ୍ର ଣାଳୟ
(printing press) ମାଲି କାନା ପାଇଁ  ବାଧ୍ୟତାମୂ ଳକ ଲାଇସେନ୍ସ  ବ୍ୟବସ୍ଥା ଲାଗୁ
କରାଯାଇଥି ଲା?

A.  ଲାଗି ଙ୍ଗ ଆକ୍ଟ (Lagging Act)

B.  ବ୍ୟାଗିଂ  ଆକ୍ଟ (Bagging Act)

C.  ଗ୍ୟାଗିଂ  ଆକ୍ଟ (Gagging Act)

D.  ମ୍ୟାଗିଂ  ଆକ୍ଟ (Magging Act)

✓

Q36 GA
Which of the following sub-regions of the Northern Plains lies
closest to the Himalayan foothills?

A.  Bhabar

B.  Khadar

C.  Bhangar

D.  Terai

✓

Q37 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଦାରି ଦ୍ର୍ୟ  ମାପି ବାର ଏକ ପଦ୍ଧତି  ନୁ ହେଁ ?

A.  ଇନକମ ଗ୍ୟାପ ଇଣ୍ଡେକ୍ସ (Income Gap Index)

B.  ହେଡ କାଉଣ୍ଟ ଇଣ୍ଡେକ୍ସ (Head Count Index)

C.  BSE ଇଣ୍ଡେକ୍ସ (BSE Index)

D.  ଦ ସେନ ଇଣ୍ଡେକ୍ସ (The Sen Index)

✓

Q38 GA
ଭାରତୀୟ ସମ୍ବି ଧାନର ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଅନୁ ସୂ ଚୀରେ ପଞ୍ଚାୟତି ରାଜ ଅନୁ ଷ୍ଠାନଗୁ ଡ଼ି କର
ଉଲ୍ଲେଖ ଅଛି ?

A.  ସପ୍ତମ ଅନୁ ସୂ ଚୀ

B.  ଅଷ୍ଟମ ଅନୁ ସୂ ଚୀ

C.  ଏକାଦଶ ଅନୁ ସୂ ଚୀ

D.  ଦ୍ୱାଦଶ ଅନୁ ସୂ ଚୀ

✓

Q39 GA
ନି ମ୍ନ ଲି ଖି ତ ଗ୍ର ହଗୁ ଡି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ପ୍ରା ୟତଃ ଭୋର ଏବଂ ସନ୍ଧ୍ୟା ସମୟରେ ଉଜ୍ଜ୍ୱଳ
ଭାବରେ ଚମକୁ ଥି ବାର ଦେଖାଯାଏ ଏବଂ ଗୋଟି ଏ ତାରକା ନ ହୋଇ ମଧ୍ୟ ସାଧାରଣତଃ
'ମର୍ନିଙ୍ଗ ଷ୍ଟାର (Morning Star) ବା 'ଇଭନିଂ  ଷ୍ଟାର' (Evening Star) ଭାବରେ
ପରି ଚି ତ?

A.  ମଙ୍ଗଳ

B.  ବୁ ଧ

C.  ଶୁ କ୍ର

D.  ନେପଚୁ ନ

✓

Q40 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ପାଇଁ  ଓମଙ୍କ ନି ୟମ ପ୍ର ଯୁ ଜ୍ୟ ନୁ ହେଁ ?

A.  ତମ୍ବା ତାର

B.  ନି କ୍ରୋ ମ୍  ତାର

C.  ଏକ ବଲ୍ବ ର ଫି ଲାମେଣ୍ଟ

D.  ପ୍ର ତି ରୋଧକ

English

✓

Q41 English
What is an unconventional style of living called?

A.  Blasphemy

B.  Bohemian

C.  Connoisseur

D.  Apostate

✓

Q42 English
Select the most appropriate option to fill in the blank.

Her voice had a ________ quality that made everyone in the room stop and listen.

A.  loud

B.  dull

C.  captivating

D.  harsh
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✓

Q43 English
Choose the sentence in which the spelling error in the given sentence has been corrected.

The commitee has decided to postpone the annual meeting until next month.

A.  The comitee has decided to postpone the annual meeting until next month.

B.  The committee has decided to postpone the annual meeting until next month.

C.  The commity has decided to postpone the annual meeting until next month.

D.  The commetee has decided to postpone the annual meeting until next month.

✓

Q44 English
Select the option that expresses the given sentence in active voice.

The documents were submitted by the students before the deadline.

A.  The students submitted the documents before the deadline.

B.  The documents were being submitted by the students.

C.  The students had submitted the documents before the deadline.

D.  The students submit the documents before the deadline.

✓

Q45 English
Select the option that can be used as a one-word substitute for the given phrase.

A feeling of intense longing for something

A.  Apathy

B.  Yearning

C.  Indifference

D.  Disdain

✓

Q46 English
Choose the correct direct speech option to complete the sentence.

She warned me not to open the file because it had a virus.
She said, “______________ a virus.”

A.  Don’t open the file because it had

B.  Not to open the file because it has

C.  I should not open the file because it had

D.  Don't open the file because it has

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q47 English
In the following question, a statement has been given in brackets. You are required to replace the statement with the correct proverb given in
the options.

When the city improved its public transport system, residents, businesses, and schools all benefited. It clearly showed that (everyone gains
when the overall condition improves).

A.  a rising tide lifts all boats

B.  charity begins at home

C.  fortune favours the brave

D.  one good turn deserves another

✓

Q48 English

Read the passage carefully and answer the questions that follow.

In a remote village in Rajasthan, water scarcity has shaped the lives of its residents for generations. Every drop of water is valued, and traditional
rainwater harvesting systems, known as “johads”, have been ingeniously used to store and channel water. Women and children walk miles daily
to fetch water, turning it into a communal activity that strengthens social bonds. Over time, modern interventions like solar-powered pumps have
complemented these age-old practices, improving efficiency without disrupting traditional methods. The village’s resilience lies not only in
technology but in the people’s collective awareness and adaptability. By preserving indigenous knowledge and embracing sustainable solutions,
the community ensures survival amid harsh climatic conditions. This delicate balance between tradition and innovation highlights the role of
human ingenuity in confronting environmental challenges. The story reflects how resource scarcity can foster cooperation, innovation, and
respect for natural systems.

What is a “johad” used for in the village?

A.  Storing and channeling water

B.  Farming crops

C.  Building houses

D.  Religious ceremonies

✓

Q49 English
What is the central theme of the passage?

A.  Modern technology replaces tradition

B.  Water scarcity and community resilience

C.  Women’s role in society

D.  Religious practices in villages

✓

Q50 English
What can be inferred about the village residents?

A.  They rely solely on modern technology.

B.  They are indifferent to environmental challenges.

C.  They value cooperation and sustainability.

D.  They have abandoned traditional practices.
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✓

Q51 English
What is the tone of the passage?

A.  Appreciative and informative

B.  Sarcastic

C.  Humorous

D.  Critical

✓

Q52 English
Which title best suits the passage?

A.  Innovation Amid Scarcity: Water Management in Rajasthan

B.  Village Festivals and Traditions

C.  The Rise of Solar Technology

D.  Women in Rural India

✓

Q53 English
The parts of a sentence are given below. While the first part (S1) is fixed and correctly placed, the remaining segments are jumbled. Rearrange
them to form a clear, meaningful, and grammatically correct sentence.

S1. She wanted
A. not come easily that evening
B. to her friend, but
C. the right words would
D. to explain everything

A.  CADB

B.  DBCA

C.  ACDB

D.  BCDA

✓

Q54 English

Replace the given word segment with the correct idiom.
To come very near to success but ultimately fail

A.  Get out of town

B.  Close, but no cigar

C.  Peas in the pod

D.  All bets are off

✓

Q55 English
Select the most appropriate ANTONYM of the highlighted word.

He believed that his daily routine was mundane and lacking excitement.

A.  ordinary

B.  expensive

C.  routine

D.  extraordinary
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✓

Q56 English
Select the word that is closest in meaning to the opposite of the highlighted word.
He felt desperate after hearing the bad news.

A.  Hopeful

B.  Content

C.  Relieved

D.  Assured

✓

Q57 English
Select the most appropriate option to fill in the blank.
If he studies hard, he _____ the exam.

A.  will pass

B.  will be passing

C.  will have passed

D.  is passing

✓

Q58 English
Complete the sentence by choosing the correct option.
Not only the parents but also the child ______ excited about the trip.

A.  are

B.  has

C.  is

D.  being

✓

Q59 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P. your body stronger,
Q. if you want to make
R. exercise regularly
S. and eat healthy food

A.  QPRS

B.  PQSR

C.  RSPQ

D.  QRPS

✓

Q60 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

She went to ___ market to buy vegetables.

A.  a

B.  an

C.  the

D.  No article required
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Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ଯେଉଁ  ମାନଙ୍କର ନି ର୍ଦ୍ଦିଷ୍ଟ ନୀତି  ନ ଥାଏ , ସେମାନେ ____ ବି ଭି ନ୍ନ ଲୋକଙ୍କ ଦ୍ୱାରା ପ୍ର ଭାବି ତ ହୋଇଥାନ୍ତି  ।''

A.  ଶାନ୍ତି ରେ

B.  ସହଜରେ

C.  ଦୁଃ ଖରେ

D.  ଈର୍ଷା ରେ

✓

Q62 Odia
"ଧୂ ଆଁ ବାଣ ମାରି ବା" ର ଅର୍ଥ ?

A.  ବଢ଼େଇ କରି  କଥା କହି ବା

B.  ସତ୍ୟ କହି ବା

C.  ଛଳ କରି ବା

D.  ବୋକା ବନେଇବା

✓

Q63 Odia
ସଠି କ ତତ୍ସମ ଶବ୍ଦ ବାଛନ୍ତୁ: “ଗାଁ ” ର ତତ୍ସମ କଣ?

A.  ଗ୍ରା ମ

B.  ଗ୍ର ମ

C.  ଗମ୍

D.  ଗ୍ରା ମୀ

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋହନ ସ୍କୁଲ ଯାଉଛି ।

A.  Mohan is going to school.

B.  Mohan was going to school.

C.  Mohan had gone to school.

D.  Mohan has gone to school.

✓

Q65 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ପ୍ର ତି  ମଙ୍ଗଳବାର ଦି ନ ତୁ ମେ ହନୁ ମାନ ମନ୍ଦି ର ଯାଅ କି  ?

A.  Have you gone to Hanuman Mandir every Tuesday?

B.  Do you go to Hanuman Mandir every Tuesday?

C.  Will you go to Hanuman Mandir ?

D.  Are you going to Hanuman Mandir every Tuesday?
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✓

Q66 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

କେରଳ ରେ ପ୍ର ତି ଟି  ଘରେ ନଡି ଆ ଗଛ ଲାଗି ଛି  ।

A.  In Kerala, every house has a coconut tree.

B.  In Kerala, every house had a coconut tree.

C.  There are so many coconut trees In Kerala.

D.  In Kerala, every house has a tree.

✓

Q67 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ। ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ|

ଭାରତରେ ନଦୀଗୁ ଡ଼ି କର ପରସ୍ପର ସଂଯୋଗୀକରଣ ଏକ ପ୍ର ମୁ ଖ ଜଳ-ପରି ଚାଳନା ପଦକ୍ଷେପ | ଏହି  ପଦକ୍ଷେପରେ ଉଦ୍ ‌ବୃ ତ୍ତ ନଦୀ ଅବବାହି କାରୁ  ଅଭାବୀ ନଦୀ ଅବବାହି କାକୁ  ଜଳ ସ୍ଥାନାନ୍ତର କରି
ଜଳ ଉପଲବ୍ଧତାରେ ଆଞ୍ଚଳି କ ଅସନ୍ତୁଳନକୁ  ଦୂ ର କରି ବା ପାଇଁ  ଲକ୍ଷ୍ୟ ରଖାଯାଇଛି । ବନ୍ୟା, ମରୁ ଡ଼ି  ଏବଂ କୃ ଷି  ସ୍ଥାୟୀତ୍ୱ ସମ୍ବନ୍ଧୀୟ ଚ୍ୟାଲେଞ୍ଜଗୁ ଡ଼ି କର ସମାଧାନ ପାଇଁ  ପରି କଳ୍ପି ତ, ଏହି  ଧାରଣା 19
ଶତାବ୍ଦୀର ହେଲେ ସୁ ଦ୍ଧା ଏହା ସ୍ୱାଧୀନତା ପରବର୍ତ୍ତୀ  ଯୁ ଗରେ ଜାତୀୟ ସ୍ବୀ କୃ ତି  ପାଇଲା। 1980 ମସି ହାରେ ଆରମ୍ଭ ହୋଇଥି ବା ଜାତୀୟ ଦୃ ଷ୍ଟି କୋଣ ଯୋଜନା (NPP), ଦୁ ଇଟି  ପ୍ର ମୁ ଖ ଉପାଦାନ -
ହି ମାଳୟ ଏବଂ ଉପଦ୍ୱୀପ ନଦୀ ପ୍ର ଣାଳୀକୁ  ନେଇ ଏକ ବ୍ୟାପକ ନଦୀ ସଂଯୋଗୀକରଣ ରଣନୀତି ର ମୂ ଳଦୁ ଆ ସ୍ଥାପନ କରି ଥି ଲା। ଏହି  ଦୃ ଷ୍ଟି କୋଣ ଅଧୀନରେ, 30 ରୁ  ଅଧି କ ନଦୀ ସଂଯୋଗ ପ୍ର କଳ୍ପ
ଚି ହ୍ନଟ କରାଯାଇଥି ଲା, ଯେଉଁ ଥି ରେ କେନ୍ -ବେତୱା ଲି ଙ୍କ୍ , ଗଙ୍ଗା-କାବେରୀ ଲି ଙ୍କ୍  ଏବଂ ପାର-ତାପି -ନର୍ମ ଦା ଲି ଙ୍କ୍  ଭଳି  ଜଣାଶୁ ଣା ପ୍ର ସ୍ତାବ ଅନ୍ତର୍ଭୁ କ୍ତ। ଏହାର ଉଦ୍ଦେଶ୍ୟ ହେଉଛି  ଏକ ସଂଯୁ କ୍ତ ଜଳ
ନେଟୱାର୍କ  ସୃ ଷ୍ଟି  କରି ବା ଯାହା ଅତି ରି କ୍ତ ମୌସୁ ମୀ ଜଳକୁ  ମରୁ ଡ଼ି  ପ୍ର ବଣ ଅଞ୍ଚଳକୁ  ଫେରାଇପାରି ବ, ଜଳସେଚନକୁ  ବୃ ଦ୍ଧି  କରି ପାରି ବ, ପାନୀୟ ଜଳ ଯୋଗାଣକୁ  ବୃ ଦ୍ଧି  କରି ପାରି ବ, ଆଭ୍ୟନ୍ତରୀଣ ଜଳ
ପରି ବହନକୁ  ଉନ୍ନତ କରି ପାରି ବ ଏବଂ ଜଳବି ଦ୍ୟୁ ତ୍  ଶକ୍ତି  ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  କରି ପାରି ବ।

ସମ୍ପ୍ରତି  ଅନୁ ମୋଦି ତ କେନ୍ -ବେତୱା ପ୍ର କଳ୍ପକୁ  ଜାତୀୟ ଆନ୍ତଃସଂଯୋଗ କାର୍ଯ୍ୟ କ୍ର ମ କାର୍ଯ୍ୟ କାରୀ କରି ବା ଦି ଗରେ ପ୍ର ଥମ ପ୍ର ମୁ ଖ ପଦକ୍ଷେପ ବୋଲି  ବି ବେଚନା କରାଯାଉଛି । ଯଦି  ସଫଳତାର ସହ
କାର୍ଯ୍ୟ କାରୀ ହୁ ଏ, ତେବେ ଏହା ଉତ୍ତରପ୍ର ଦେଶ ଏବଂ ମଧ୍ୟପ୍ର ଦେଶର ଅଞ୍ଚଳଗୁ ଡ଼ି କୁ  ଜଳସେଚନ, ପାନୀୟ ଜଳ ଏବଂ ବି ଦ୍ୟୁ ତ୍  ଯୋଗାଣ ମାଧ୍ୟମରେ ଲାଭଦାୟକ ହେବ ବୋଲି  ଆଶା କରାଯାଉଛି ।
ଏହି  ପଦକ୍ଷେପର ସମର୍ଥ କମାନେ ଯୁ କ୍ତି  ଦି ଅନ୍ତି  ଯେ ଏହା ଖାଦ୍ୟ ସୁ ରକ୍ଷାକୁ  ସୁ ଦୃ ଢ଼ ​​କରି ବ, ଜଳବାୟୁ -ପ୍ର ବର୍ତ୍ତିତ ପାଣି ପାଗ ଚରମ ପ୍ର ଭାବକୁ  ହ୍ରା ସ କରି ବ, ଗ୍ରା ମାଞ୍ଚଳ ଜୀବି କାକୁ  ସମର୍ଥ ନ କରି ବ ଏବଂ
ଆଞ୍ଚଳି କ ଆର୍ଥିକ ବି କାଶରେ ଯୋଗଦାନ ଦେବ। ପରି ବେଶବି ତ୍ମାନେ ଚେତାବନୀ ଦେଇଛନ୍ତି  ଯେ ନଦୀଗୁ ଡ଼ି କର ପରି ବର୍ତ୍ତ ନ ନଦୀ ପରି ସଂସ୍ଥା, ବନ୍ୟପ୍ରା ଣୀ ବାସସ୍ଥାନ ଏବଂ ପ୍ରା କୃ ତି କ ପ୍ର ବାହ ଢାଞ୍ଚାକୁ
ପ୍ର ଭାବି ତ କରି ପାରେ। ସମ୍ପ୍ରଦାୟର ବି ସ୍ଥାପନ, ​​ଆନ୍ତଃରାଜ୍ୟ ଜଳ ବି ବାଦ, ଉଚ୍ଚ ଆର୍ଥିକ ଖର୍ଚ୍ଚ  ଏବଂ ଏହି  ପ୍ର କଳ୍ପଗୁ ଡି କର ଦୀର୍ଘ କାଳୀନ ଅବଧି  ଉପରେ ମଧ୍ୟ ଚି ନ୍ତା ପ୍ର କାଶ ପାଇଛି । ସମାଲୋଚକମାନେ
ସତର୍କ ତାର ସହି ତ ମୂ ଲ୍ୟାଙ୍କନ, ଦୃ ଢ଼ ପରି ବେଶଗତ ସୁ ରକ୍ଷା ଏବଂ ଜଳଛାୟା ବି କାଶ, ବର୍ଷା ଜଳ ଅମଳ ଏବଂ ସ୍ଥାନୀୟ ଜଳସଂଗ୍ର ହର ପୁ ନରୁ ଦ୍ଧାର ଭଳି  ବି କଳ୍ପ ଜଳ-ସଂରକ୍ଷଣ ପଦକ୍ଷେପର ଆବଶ୍ୟକତା
ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରନ୍ତି  ।

ନଦୀ ସଂଯୋଗୀକରଣ ପାଇଁ  ଜାତୀୟ ଦୃ ଷ୍ଟି କୋଣ ଯୋଜନା କେବେ ଆରମ୍ଭ ହୋଇଥି ଲା ?

A.  1950

B.  1960

C.  1980

D.  2000

✓

Q68 Odia
କେଉଁ ଟି  ପ୍ର ଥମ ଅନୁ ମୋଦି ତ ପ୍ର ମୁ ଖ ନଦୀ ସଂଯୋଗ ପ୍ର କଳ୍ପ?

A.  ଗଙ୍ଗା-କାବେରୀ

B.  କେନ୍ -ବେତୱା

C.  କୃ ଷ୍ଣ-ଗୋଦାବରୀ

D.  ମହାନଦୀ-ଗୋଦାବରୀ

✓

Q69 Odia
ନଦୀ ସଂଯୋଗୀକରଣ ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ ହେଉଛି  ______.

A.  ପର୍ଯ୍ୟ ଟନ ବୃ ଦ୍ଧି

B.  ଉଦ୍ ‌ବୃ ତ୍ତ ଠାରୁ  ଅଭାବୀ ଅବବାହି କାକୁ  ଜଳ ସ୍ଥାନାନ୍ତର କରି ବା

C.  ଅଧି କ ବନ୍ଧ ନି ର୍ମା ଣ

D.  ପରି ବହନ ଖର୍ଚ୍ଚ  ହ୍ରା ସ
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✓

Q70 Odia
ନଦୀ ସଂଯୋଗୀକରଣ ସହି ତ ଜଡି ତ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଚି ନ୍ତାର ବି ଷୟ?

A.  ପରି ବେଶଗତ ବି ଭ୍ରା ଟ

B.  ଭାରୀ ଆର୍ଥିକ ଖର୍ଚ୍ଚ

C.  ଲୋକଙ୍କ ସମ୍ଭାବ୍ୟ ବି ସ୍ଥାପନ

D.  ଉପରୋକ୍ତ ସମସ୍ତ

✓

Q71 Odia
ନଦୀଗୁ ଡ଼ି କର ପରସ୍ପର ସଂଯୋଗୀକରଣ ମୁ ଖ୍ୟତଃ କଣ ପାଇଁ  ଲାଭଦାୟକ ହେବ ବୋଲି  ଆଶା କରାଯାଉଛି ?

A.  କୃ ଷି  ଏବଂ ଜଳ ଯୋଗାଣ

B.  ପର୍ଯ୍ୟ ଟନ ଶି ଳ୍ପ

C.  ଖଣି  କ୍ଷେତ୍ର

D.  ବି ମାନ ପରି ବହନ

✓

Q72 Odia
ମି ଶି ଯାଏ ଯଥା ପ୍ର ଭାତୀ ତାରା ରବି  କି ରଣ - କେଉଁ  ପଦଟି  ସାଦୃ ଶ୍ୟବୋଧକ ଅବ୍ୟୟ ।

A.  ମି ଶି ଯାଏ

B.  ପ୍ର ଭାତୀ

C.  ତାରା

D.  ଯଥା

✓

Q73 Odia
“ସ୍ଵକୀୟ” ର ବି ପରୀତ ଶବ୍ଦ ଲେଖ ।

A.  ମର୍ତ୍ତ୍ୟ

B.  ରୁ କ୍ଷ

C.  ପରକୀୟ

D.  ଅକ୍ଷତ

✓

Q74 Odia
ସଠି କ୍  ବନାନ ଥି ବା ବାକ୍ୟଟି  ଚି ହ୍ନଟ କର ।

A.  ସେ ଯଣେ କୃ ତବି ଦ୍ୟା ବ୍ୟକ୍ତି  ।

B.  ସେ ଜଣେ କୃ ତବି ଦ୍ୟ ବ୍ୟକ୍ତି  ।

C.  ସେ ଯଣେ କୃ ତି ବି ଦ୍ୟ ବ୍ୟକ୍ତି  ।

D.  ସେ ଜଣେ କୃ ତବି ଦ୍ଧ ବ୍ୟକ୍ତି  ।

✓

Q75 Odia
"ପକ୍ଷୀଟି  ଉପରକୁ  ଉଡ଼ି ଗଲା" ଏଠାରେ 'ଉପରକୁ ' କି  ପ୍ର କାର କ୍ରି  ୟା ବି ଶେଷଣ?

A.  କାଳବାଚକ

B.  ସ୍ଥାନବାଚକ

C.  ଗୁ ଣବାଚକ

D.  ପରି ମାଣବାଚକ
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Computer

✓

Q76 Computer
Which shortcut key starts a PowerPoint slide show from the
beginning?

A.  F5

B.  F7

C.  F9

D.  Ctrl + S

✓

Q77 Computer
MS ଏକ୍ସେଲ 2021 ରେ ଟାଇପ କରି ବା ପରେ ସେଲ ଏଡି ଟକୁ  କେଉଁ  କି -ବୋର୍ଡ  କି  ନି ଶ୍ଚି ତ
କରେ?

A.  Shift

B.  Esc

C.  Enter

D.  Ctrl

✓

Q78 Computer
ପାୱାରପଏଣ୍ଟରେ PC ରେ ସେଭ ହୋଇଥି ବା ଏକ ପୂ ର୍ବ ରୁ  ଥି ବା ପ୍ରେ ଜେଣ୍ଟେସନ୍  ଫାଇଲ
ଓପନ କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ସଠି କ୍  ପଦକ୍ଷେପ ଅଟେ?

A.  File → New → Blank Presentation

B.  File → Open → Select the file → Click Open

C.  Home tab → Insert → Slide Show

D.  View tab → Slide Sorter → Double click file

✓

Q79 Computer
ଯଦି  ଆପଣ ଚାହାନ୍ତି  ଯେ ଫାଇଲ ଓପନ ହେବା ମାତ୍ରେ  (ଏଡି ଟିଂ  ମୋଡକୁ  ନ ଯାଇ)
ଆପଣଙ୍କର ପ୍ରେ ଜେଣ୍ଟେସନ ଅଟୋମେଟି କ ଆରମ୍ଭ ହେଉ, ଆପଣଙ୍କୁ  କ'ଣ ଭାବେ ସେଭ
କରି ବାକୁ  ପଡି ବ?

A.  .pptx

B.  .ppsx

C.  .potx

D.  .odp

✓

Q80 Computer
While sending an email with an attachment, which of the following
steps is correct?

A.  Type the message and click Send before attaching the file.

B.  Attach the file using the paperclip icon before sending the
email.

C.  Copy and paste the file into the subject line.

D.  Rename the file to “Attachment” and skip uploading it.

✓

Q81 Computer
Which feature in an email program automatically checks spelling
mistakes while writing an email?

A.  Email Signature

B.  Spell Check

C.  Attachment

D.  Drafts

✓

Q82 Computer

In the context of Formatting Documents in MS Word 2021, match
the options in Column A with their corresponding functions in
Column B.

Column A – Text
Option

Column B – Function

1. Cut
a) Duplicates the selected text to the clipboard
without deleting it

2. Copy b) Deletes the selected text and places it on the
clipboard

3. Paste
c) Adds the content from the clipboard to the
current cursor location

4. Undo d) Cancels or reverses the most recent editing
or formatting action

A.  1–b, 2–a, 3–c, 4–d

B.  1–a, 2–b, 3–d, 4–c

C.  1–b, 2–c, 3–a, 4–d

D.  1–d, 2–b, 3–c, 4–a

✓

Q83 Computer
କେଉଁ ଟି  କମ୍ପ୍ୟୁ ଟରର ବ୍ରେ ନ ଅଟେ?

A.  ଇନପୁ ଟ ଡି ଭାଇସ

B.  ଆଉଟପୁ ଟ ଡି ଭାଇସ

C.  ମେମୋରୀ ଡି ଭାଇସ

D.  ସେଣ୍ଟ୍ରାଲ ପ୍ରୋ ସେସି ଙ୍ଗ ୟୁ ନି ଟ

✓

Q84 Computer
କାହାକୁ  କମ୍ପ୍ୟୁ ଟରର ଜନକ କୁ ହାଯାଏ?

A.  ଚାର୍ଲ ସ ବାବେଜ (Charles Babbage)

B.  ଭି ଣ୍ଟନ ସର୍ଫ  (Vinton Cerf)

C.  ଆଲାନ ଟ୍ୟୁ ରିଂ  (Alan Turing)

D.  ଇଭାନ ମି ସନର (Ivan Misner)
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✓

Q85 Computer
Which component of OS handles memory allocation?

A.  Process Manager

B.  Memory Manager

C.  File Manager

D.  I/O Manager

✓

Q86 Computer
In Microsoft Office Professional 2021, where can we find the bullets
tab?

A.  Under Design tab, in the Document formatting group

B.  Under Layout tab, in the Paragraph group

C.  Under Home tab, in the Paragraph group

D.  Under Insert tab, in the Pages group

✓

Q87 Computer
Which of the following is NOT a valid data type in MS Excel?

A.  Text

B.  Number

C.  Date

D.  Image

✓

Q88 Computer
What is the primary function of a PCB in electronic devices?

A.  To store operating system data

B.  To mechanically support and electrically connect
components

C.  To increase wireless signal strength

D.  To cool down the CPU

✓

Q89 Computer
When you search for help in MS Word using the search box, what
type of results will you typically see first?

A.  Video tutorials from YouTube

B.  Help articles and step-by-step instructions

C.  User comments and reviews

D.  Software update notifications

✓

Q90 Computer
In Microsoft Excel, which option allows you to start with a blank
spreadsheet?

A.  File > Open

B.  File > Print

C.  File > New > Blank Workbook

D.  View > Gridlines
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Reasoning

✓

Q91 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ,
'A # B' ର ଅର୍ଥ  'A ହେଉଛି  B ର ପତ୍ନୀ',
'A % B' ର ଅର୍ଥ  'A ହେଉଛି  B ର ଭାଇ',
'A $ B' ର ଅର୍ଥ  'A ହେଉଛି  B ର ବାପା' ଏବଂ
'A @ B' ର ଅର୍ଥ  'A ହେଉଛି  B ର ମା' ।

ଯଦି  'L $ A % N @ S # P' ତେବେ L କି ପରି  P ସହି ତ ସମ୍ପର୍କିତ?

A.  ପତ୍ନୀଙ୍କ ବାପା

B.  ପତ୍ନୀଙ୍କ ବାପାଙ୍କ ବାପା

C.  ପତ୍ନୀଙ୍କ ମାଆ'ଙ୍କ ଭଉଣୀ

D.  ପତ୍ନୀଙ୍କ ମାଆ'ଙ୍କ ବାପା

✓

Q92 Reasoning
ଆଠ ଜଣ ବ୍ୟକ୍ତି  (A, B, C, D, E, F, G ଏବଂ H) କେନ୍ଦ୍ରକୁ  ମୁ ହଁ  କରି  ଏକ ବୃ ତ୍ତାକାର
ପରି ସରରେ ବସି ଛନ୍ତି  । A ର ଡାହାଣକୁ  ତୃ ତୀୟ ସ୍ଥାନରେ D ବସି ଛନ୍ତି  । A ର ବାମକୁ  ଦ୍ୱି ତୀୟ
ସ୍ଥାନରେ B ବସି ଛନ୍ତି  । D ର ଡାହାଣ ପଟରୁ  ଗଣନା କଲେ D ଏବଂ B ମଧ୍ୟରେ କେତେ ଜଣ
ବ୍ୟକ୍ତି  ବସି ଛନ୍ତି ?

A.  ଚାରି

B.  ତି ନି

C.  ଦୁ ଇ

D.  ପାଞ୍ଚ

✓

Q93 Reasoning
ସାତଟି  ବାକ୍ସ F, G, H, I, U, V ଓ W କୁ  ଗୋଟି ଏ ଉପରେ ଗୋଟି ଏ କରି  ରଖାଯାଇଛି  କି ନ୍ତୁ
ସମାନ କ୍ର ମରେ ରଖି ବା ଆବଶ୍ୟକ ନୁ ହେଁ  । I ଉପରେ କୌଣସି  ବାକ୍ସ ରଖାଯାଇ ନାହିଁ । I ଓ
U ମଧ୍ୟରେ କେବଳ ତି ନୋଟି  ବାକ୍ସ ରଖାଯାଇଛି  । H ଓ F ମଧ୍ୟରେ କେବଳ ଗୋଟି ଏ ବାକ୍ସ
ରଖାଯାଇଛି  । Uର ଠି କ ଉପରେ Fକୁ  ରଖାଯାଇଛି  । H ଓ W ମଧ୍ୟରେ କେବଳ ଚାରୋଟି
ବାକ୍ସ ରଖାଯାଇଛି  । G ଉପରେ କୌଣସି  ସ୍ଥାନରେ V କୁ  ରଖାଯାଇଛି  । V ତଳେ ଦ୍ଵି ତୀୟ
ସ୍ଥାନରେ କେଉଁ  ବାକ୍ସକୁ  ରଖାଯାଇଛି ?

A.  F

B.  H

C.  U

D.  W

✓

Q94 Reasoning
ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର-ସଂଖ୍ୟା ପୁ ଞ୍ଜ
ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ପ୍ର ତି ସ୍ଥାପି ତ କରାଯାଇପାରି ବ?

THE98, PDA89, LZW80, HVS71, ?

A.  DRO62

B.  DIO62

C.  DRU62

D.  SRO62

✓

Q95 Reasoning
ଯଦି '+' ଓ '–' ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ ହୁ ଏ ଏବଂ '×' ଓ '÷' ପରସ୍ପର ସହି ତ
ଅଦଳବଦଳ ହୁ ଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?) ସ୍ଥାନରେ କ'ଣ ହେବ?
15 – 49 × 7 + 8 ÷ 2 = ?

A.  6

B.  12

C.  22

D.  28

✓

Q96 Reasoning
OF 21 is related to MC 3 in a certain way. In the same way, JL 28 is
related to HI 10. To which of the following is NG 24 related, following
the same logic?

A.  LD 6

B.  KO 8

C.  BH 5

D.  VG 4

✓

Q97 Reasoning
In a certain code language, ‘pan fresh oven’ is coded as 'sm al zu'
and ‘oven unit giant’ is coded as ‘al xq hj’. How is ‘oven’ coded in that
language?

A.  al

B.  sm

C.  zu

D.  xq

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
one out is not based on the number of consonants/vowels or their
position in the letter cluster.)6187

A.  BC-FG

B.  GH-JK

C.  ST-VW

D.  MN-PQ
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✓

Q99 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । କେବଳ ବାମରୁ  ଡାହାଣକୁ  ଗଣନା
କରାଯି ବ । (ଦ୍ର ଷ୍ଟବ୍ୟ: ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକକ-ଅଙ୍କ ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ ।)

(ବାମ) 9 6 8 5 8 5 9 8 6 3 6 6 3 6 8 6 7 1 1 9 9 8 8 7 1 1 4 (ଡାହାଣ)

ଏପରି  କେତେଟି  ଯୁ ଗ୍ମ  ସଂଖ୍ୟା ଅଛି , ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ପୂ ର୍ଣ୍ଣ ବର୍ଗ  ଏବଂ ତା
ଠି କ ପରେ ଏକ ଯୁ ଗ୍ମ  ସଂଖ୍ୟା ଅଛି ?
(ଟି ପ୍ପଣୀ: 1 ମଧ୍ୟ ଏକ ପୂ ର୍ଣ୍ଣ  ବର୍ଗ  ଅଟେ)

A.  ତି ନି

B.  ଦୁ ଇ

C.  ଏକ

D.  ଚାରି

✓

Q100 Reasoning
ନି ମ୍ନ ରେ ଏକ ପ୍ର ଶ୍ନ  ଏବଂ ଦୁ ଇଟି  ବି ବୃ ତି  ଦି ଆଯାଇଛି  । ଦି ଆଯାଇଥି ବା ପ୍ର ଶ୍ନ  ଓ ବି ବୃ ତି  ଗୁ ଡ଼ି କୁ
ଭଲ ଭାବରେ ପଢ଼ନ୍ତୁ ଏବଂ ବି ବୃ ତି ରେ ଦି ଆଯାଇଥି ବା ତଥ୍ୟ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦେବା ପାଇଁ
ଯଥେଷ୍ଟ କି  ନୁ ହେଁ  ତାହା ସ୍ଥି ର କରନ୍ତୁ ।
ବି ବୃ ତ୍ତି : ସମସ୍ତ ଜାମ କୋବ୍ରା  ଅଟେ । ସମସ୍ତ କୋବ୍ରା  ମଗ ଅଟେ ।
ନି ଷ୍କର୍ଷ  (I) : କି ଛି  ମଗ କୋବ୍ରା  ଅଟେ ।
ନି ଷ୍କର୍ଷ  (II) : ସମସ୍ତ ଜାମ ମଗ ଅଟେ ।

A.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଓ (II) ଅନୁ ସରଣ କରେ

B.  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) ଅନୁ ସରଣ କରେ ନାହିଁ

C.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ

D.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ
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